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Special notice

Before using this information and the product it supports, read the information in Notices on page xxxii.
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Chapter 1. Overview

HCL DevOps Test Embedded (Test Embedded) is delivered with some examples. For the HCL DevOps Test Embedded
for Eclipse IDE (Test Embedded for Eclipse IDE), they are in the <i nst al | ati on f ol der >/ exanpl esEcl i pse.
The following guide uses the example MUIproj to display various features. The guide covers the following features:

« The application build

» Code coverage

* MISRA rules review

« The call graph visualization
« The test generation

* The stub creation

» The execution of the test



Chapter 2. Importing the project in DevOps Test Embedded
for Eclipse IDE

You can either create a new project or you can import your existing Eclipse projects in your HCL DevOps Test

Embedded (Test Embedded) workspace.

Starting Test Embedded for Eclipse IDE
On Windows:

- Before stating, set the environment variables HCL_LICENSING_URL and HCL_LICENSING_ID with the

information provided by HCL.
* Open the Windows start menu and select from the menu HCL DevOps Test Embedded for Eclipse IDE in the

group DevOps Test Embedded
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B | HCL DevOps Test Embedded for Echipse (D€

{33 HEL Devps Test Embedded for Ech... e
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L HCLDevOps Test Embedkled Studio  E¥PIne
. HCL DevOps Test Embedded TOP List
E’ Release Motes 202312 (.0.0) u
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E
D Eclipse
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-
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On Linux

« In the installation folder, edit the filet est rt i ni t . sh and update the following environment variables:
o TESTRTDIR with the correct installation folder
o HCL_LICENSING_URL and HCL_LICENSING_ID with the information provided by HCL

* Run the command: . testrtinit.sh

» Then run the command: . start_visual test.sh &
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Create your own workspace. Alternatively you can select an existing workspace.

@ Eclipse Launcher

Select a directory as workspace
HCL OneTest Embedded uses the workspace directory to store its preferences and development artifacts.

Workspace: | C:\workspaces\WSemph w Browse..,

[] Use this as the default and do not ask again
b Recent Workspaces

Importing the project MUIproj

1. Select the menu File > Import.

2. Select General > Existing Projects into Workspace in the opened wizard, and then click Next.
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@ Import

Select

Create new projects from an archive file or

Select an import wizard:
type filter text

v & General
I Archive File
I* Existing Projects into Workspace
4 File System
. Preferences
4 Projects from Folder or Archive
> & C/Ce+

3. Click Select archive file, and then click Browse... on the same line and select the file MJI pr oj . zi p in the
folder<i nstal | ati on fol der >/ exanpl esEcl i pse.
4. Click Finish.
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A new project MJI pr oj is created. You can see it in the project explorer (if this view is not already open, you

can open it by selecting the menu Window > Show View > Project Explorer.

File Edit Mavigate Search Project Run W
][0][m] -
F Project Explorer
v 15 MUlproj
? Lg'l'est
pi Includes
= MUI
= TestRT_win32
=tst

WO W W




Chapter 3. Building and running the application

DevOps Test Embedded comes with many Target Deployment Port (TDP) for different compilers. For more

information about Target Deployment Port, see Target deployment port overview.

This project was initially designed for C Visual Studio 2019. If you do not have this compiler installed or if you are on

Linux, you need to modify the Target Deployment Port accordingly.

When you install DevOps Test Embeddedon your computer, the installer checks your compilers installation and create

the following TDP for you:

+ C GNU if it finds a gcc native compiler (Cygwin or MinGW)

« C Visual if it finds a Microsoft Visual compilers
You can update this project with any one of them.
Modifying the TDP in the settings

1. Right click the project MUIproj and select from the menu Properties in the Project Explorer.
2. Select C/C++ Build > Settings from the left menu tree in the wizard.

G Properties for MUlproj

Resource
Builglers
w CfC++ Build
Build Vanables
Environment
Logging
Settings
Tool Chain Editor
C/Cs+ General
Project Facets
Project References
Run/Debug Settings
Server
Service Policies
Task Tags
Validation

3. Alternatively, you can click the settings icon on the toolbar (make sure that you are in the perspective C/C+
+ or DevOps Test Embedded). This open the Properties settings directly.

4. In the right panel of the wizard, select the tab Build TDP (if this tab is not displayed, increase the width of the
wizard or use the right arrow to make it appear).


https://help.hcltechsw.com/devops/test/embedded/9.0.0/docs/topics/ctdpovw.html
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(D properties for MUlprej m| X
type filter text Settings v cow ow
» Resource
Builders
w C/C++ Build Configuration: | TestRT_win32 [ Active | ~  Manage Configurations...
Build Variables
Environment
Legging A Build Steps Build Artifact @ Binary Parsers @ Error Parsers  Build TOP  Build Settings S
Settings
Tool Chain Editor v Target DQF|W Port Name Value
y C/Cs+ General Compiler Options
Project Facets Linker Options Target deployment p...  C Visual Studic 2019
Project References Advanced Directery cvisual2019
Run/Debug Settings
Server Initial definition file tp.ini
Service Policies Source file language  C language
Task Tags Obyject file extension oby
> Validation Static library extension  lib
Dynamic library exte...  dll
Binary file extension exe
Source file extension 4

5. In the Target Deployment Port property, click C Visual Studio 2019 and select C GNU from the drop-down list

(or C Visual depending on the compiler you have on your computer).

C VxWorks 5.4 for VaSim on Windows
Initial definion file C VxWorks 54 for ppc on Windows

C Win32 - Gnu

Source file language € Wind? - Grubd

DObject file extension C++ ARM Compiler - ARMulatar 1.0
Static library extension _
; Co v Green Hills
liby {198
Dynamic library exte Co+ PowerPC DiabData SingleStep Simulator for Windows
Binary file extension

Ce+ Visual

Settings = S
Configuration: | TestRT_wind2 [ Active | “ | Manage Configurations... Py =
# Build Steps Build Artifact [si} Binary Parsers @@ ErorParsers Build TDP  Build Settings | * | *

¥ T-rgltDeFrwmujn - Name Valuwe (En)
Compiler Options
Linker Options Target deployment p.. | bual Studio 2014] Fl X I
Advanced Directory C Visual Studio 2015 &

W

Source file extension ¢

6. Click Apply, and then Close.

Building the project

Now this project can be built by using this TDP. The default configuration involves performing the build with both

Coverage and MISRA Code Review options enabled.



Chapter 3. Building and running the application

1. Right click the project MUIproj and select the option Build Project from the menu in the Project Explorer.

- Project Explorer 37 [ C/C=+ Projects 55 Mavigator = -
Bg -
i esp
% Lé Derna
» g engineSimulator
y LS gear
» i matt
v 2% MUIpe Mew 3
B e
3~
» = MI Open Call Graph
=T Openin New Window
¥ = st
X eo Remame_.
» Eaun [ Copy Ctebe
) 1SI9E o Dete Delete
s 5 Tuten :
Paste Ctrls ¥
e Imiport...
e Esport.
Build Project
Clean Project
Fefresh F5
Close Project
Close Unrelated Projects

The console view displays the build log. The build must successfully complete up to the linking phase.

Note: It can take some minutes to complete.
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Running the application

This application contains a simple main that can be run.
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1. Open the node Binaries in the MUIproj project In the project explorer.

i Project Explorer 52 | Hg) C/C++ Projects 5. Nav

5 csp
=5 Demo
» =% engineSimulator
> i gear
- i matt
v h_—“,:r MUIproj
> (2 Test
v #¥ Binaries
. %5 MUIproj.exe - [amd64/le]
> il Includes
> = MUl
> (= TestRT_win32
' B tst
(X] confrule_2012xmil
=5 sun
[5{ testgen

2. Right-click MUIproj.exe and from the menu select Run As > Instrumented Application.
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{3 Progect Explorer 1] E CiC+» Proects 5. Navigatos = 0
'L'.- (37
b Demo
L‘,. gnglnﬂ.lmul;lgr
14 gear
i mast
w BE MiUlipeey
= Test
w gl Bananes
L Mulprey.
np I lades — '
e MUl Open
& TestRT wamdy Open With B
e st
| confrule_ 201 | Cogry Cirl+C
b sn Paite tle W
.
i estgen M Delete Dielete
=5 Tutoral
Maowe...
Renumie_.
L Impoit
E
e B 2 Comcle |
Fefresh F5 LI0T Bunld Consode [MUIpacy|
T LARITL 2 ma L NIT o lamabaablh 5o Y2 WA T w4
Run s ¥ S 1 Ruan on Senver Ah=Shift= X B |3, 3
Diebug s » & instrumented Application |':;"
. 3
Puofile As » [T] 3local C/Ce+ Application [sez. 3
s 1
Validete Raun Configurations e
%' Run C/Ce = Code Analysis T PO Er e T BTt C ST ROTE 5.
) - » [« MUTYere WI_bluetooth.cz50:19] Rule M. 3
Target:C: WProgras F Lles \HCL\HCLOne Test \ Enbeddd
Ceampare With » PRl C \Users VWOTE workspace V' PMUT prof\TestRT _wi

This Instrumented Application option runs the just-compiled application and then launch different tools to
generate reports depending on the settings.

Note: If Eclipse prompts you in case of errors in the project, ignore it and click Yes.

Viewing code coverage report

After the test run, all the reports are collected in a single file that you can find under the virtual node Test.

1. In the Project Explorer, expand the node Test > Application Result in the MUIproj project.

There is a new file called MUl pr oj . exe with the date of the test run and a status.

2. Right-click the file and from the menu, select the option Open With > Coverage.

13



Getting started with DevOps Test Embedded for Eclipse IDE

(' Proect Explorer =1 GRC/Co Projects W5 Navigator = A

& op

e Do

i gear

= man
w g MUipiey

w o T

w i Appheation Result
B WRpecie

L= Data Pool
5 Repedt Open
::c Open With P D CodeReoes
& e :
LR Test Marnesc Renamse_ .
0 TestResut [ Copy Cidec W HTML Repors ¥
5i Test Suste S Dicbete Delete B Coverage
0 Test Suste R
w @ Binanies [ R
© MUlprepene - o4 Export —
B el - - Plasce Edbor
C o mﬂ £ b - Defauit Eter
b [ _“u
v et - ity
x| confrule 2012.3m v WUT L e WWI_bluetooth.e:
[ F Run CCes Code Anabyin VT \are WE_blestesth. g
& teatgen Team y pUTvere Ul _bleetooth.c:
T Wulvere Wi _bleetooth.c:
e Comparn With ¥ IvuTvsecWI_bleetooth.c:
Rieplace With » pvThvsrc\WI_bleetooth.co
WUTvsrc\WI_bleetooth.co

The Coverage viewer is opened and displays a graph with the different coverage level percentages. For more
information, see Code coverage overview and Coverage levels.

B Covtragga fow MUpegy awe -Apr- X000 WIT T 2 O =

2
[m——
~ e
i, W PRESSURE SENSORLC
L R T

Global Coverasge

L W e
90 Ll e D
Ll T
Lt Lo
S W RO
o W ENCODERH
W Fuschsnd
E D Functsons and exks
O Sustwman bk
B Decison
| Loops

e 3 B 8 &§ £ 8 3 B B

#3 L2 L s ] Bz 333

Source | Rt

The Outline option on the Coverage viewer allows you to navigate on the source code for each compilation
unit.

3. Click on any one of them. A copy of the source code is now displayed with different colors:



https://help.hcltechsw.com/devops/test/embedded/9.0.0/docs/topics/ccovovw.html
https://help.hcltechsw.com/devops/test/embedded/9.0.0/docs/topics/ccovlevels.html

- Green: the code is covered

> Red: the code is not covered

o Orange: the code is partially covered

> Black: no code

Chapter 3. Building and running the application

IR Coverage for Mifproj eve 25-Ape- 2022 14211
" Saved to this PC

¢ MUI_pressice_swnwusiw

ay
#imcluds

#include
#imclude "MOI_Ti

int previcusReadings[10]:
int t'..".é:tldbill.'

3T (ABT SOCUDESY,

inT Desding, inT SLI4)

-

BE Outline

Covensge outlne

w

Reet
L5, MRA_PRESSURS_SENSOR.C
L&, W BLUEROTH.C

L2 MUMRING

L& MUA_READER.C

L5 M TNER.C

L& MULLOGC

L2, MU CONPIGURATION.C
L& M ENCODERH

For more information, see Using the Code Coverage Viewer to view reports. A similar report exists in

HTML format. You can open it in a browser:

4. Right click on the same file and from the menu, select the option Open With > HTML Reports > Coverage.

(5 Project Explorer 11| [ C/C e+ Projects 5. Navigatar = 0 R Covernge for MUlprogeoe 25-Apr-2022 142711 12
Ju
v I e * MUI_pressure Sensor.c
+ 1% Dema : .
v 15 engineSamulator
y T gear #include "HUI_blustooth.h®
1': 9 Pinclude "HUI_:DnE:.qI.:r-:t.i:\n.h"
r g it finclude "HUI_encoder.h®
~ & MUlproj finclude "HUI log.h"
b I.S Test finclude '.HUI‘_pre_-lr.are_.:er.:u: "
w L Application Result finclude "HUI_reader.h”
B MUlproj.exe 25-Ape-2022 1462711 |F 'm ) ToromTT 3 z.h"
= Data Pool
10] =
G Report Open 219
3 Stub Open With * D CodeReview
o L Test Case c
» LR Test Hamess Rename... . vt
D Test Result B Copy Ctiec b HTMLReports ¥
o Ll Test Suite 8 Coversge
Delete Delete
L Test Suite Results X
~ 44 Binsries fa  bmport... P R
» 3 MUlprojece - [amadbd i) o Export System Editor
¥ [ Includes In-Place Editor
g MU L = Default Editor
e TectET ainld

Viewing MISRA code review report

DevOps Test Embedded supports MISRA C 2004 rule, see Code review MISRA 2004, and MISRA C 2012, see Code
review MISRA 2012 rules. You can open the report generated by this feature in the following way.
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1. Right click the node MUIproj.exe in the Application Result node, and then select from the menu Open With >
Code Review .

[{ Project Explorer 57 [ C/C++ Projects 5. Navigator = A

S esp
y 1£% Demo
» ey engineSimulator
» ‘,5 gear
> :-?c' migtt
v 5 MUlprgj

v = Test

w L Applhication Result
B MUlproj.exe 25-Apr- 1077 1A [Daread]

L Data Pool Mew H
i Report
0
(2 Stub =
» Lgh Test Case Open With * &3 CodeReview
5 O3 Test Harness e B Coverage
({3 Test Result
» L? Test Suth: [® Copy cubec | @ HIML Reports ’
g C
L Test Suite Results K Delete Delete . overage
w 4 Binaries . -, [— [E  Text Editor
> % MUlproj.ese - [amd6d/h 5| System Editor
& i3 Export.. =
> fapl Includes i Dlaes Eelitar

The code review viewer is opened. The outline view allows you to navigate to the different files of the
application (.h and .c). The central panel displays the rules that is raised during the analysis for the selected
file. If you click on a rule, the source code editor opens in the selected file, at the line where the error was

found.
@ MUApro e 15-Hov- 2023 115708 2 Guthng
| Diavellips Tt Embesiiad MESRA C-3012 Aspon using T -
IE) Copyright 1M Corp. 20052018 1 HEL T Lid 2017-2019. All Rights Fleserved » 42 NN _bluetooth b
ot atn fim & Pegrnen Pt HCL D 012w 4w contiguation
(R o ALy O juon » ol MU encodech
(rE—— W e 18 1 1SE4T 203 ¥ ﬁw_hqh
| Ay e [T -,ﬁmﬂm_wh
[Fids wehy mrmory gr wwerargs. [F] > S MU readech
it of e o A W timae
[ umt ol ey B R MU contigurations
1 & e O T I Sampty L e o WLINcAMILY_ blestooth. b » ﬂw_lngc
[Fin cme [ved biowe 15 1120002 2020 ] » 4R M mainc
I""‘-"""""-"‘F‘ ]! | b ﬁm_mnm_umt
1.1 line 18 oolume §: Rule M3 1.7 » 48N MU readens
Ermor Eutrerad adentifion: ' MUBSConliguns and ‘MUNDIConnact are dentinal in the fint ' dharscien gronng case > 4R MU timer.c
1.2 e 37 cokam & Rk A3, 1.7 » 4 U1 bluetoothuc
Ermsr. Entevea aderibforrs ‘MUBMEakeet el MUBNBosef e sderalei sl Bt Fitd ‘B (Rirsiien sgronng fise O deattivated rules by uisr
1.3 line 29 columes 8: Ride M3 1.7 ) rudes sratisticy

Erroe Eatgrrasl aherdfonn: LISt 5re  MLIGERSCRewS 55w centssl o the fnt 8 JRarscten gromng Case
2 C e HOTEW SamphyddUigs o N UMUY_eonfiguiintion B

[Fom e [waa mow 15 1130002 200 |
[t ot ey pmd e le |
1 C AV HOTEUW Samply L ML ML 8o h

[Fam sae | e 15 11:3012 2023 |
[t ot #rmrs o warming [z |

3 i dvaene Tern w

A similar report exists in HTML format. You can open it in a browser:

2. Right click on the same file and select from the menu Open With > HTML Reports > Code Review .
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Exporting the HTML reports

Chapter 3. Building and running the application

All the reports, including the HTML reports, are stored in a single zip file. You can easily extract only the HTML reports

in a folder with an index that lists all the exported files.

1. Right click on the result file and select the option from the menu Open With > HTML Reports > Export Reports

(5 Project Explorer 5 | B CAC++ Projects . Mawigator = 0
B9 <
» 2% op
3 125 Demo
3 g5 enganaSimulator
3 2% gear
y 15 matt
» % MUlproj
w [ Test
w L Applicatson Result
8 MUlproj.cxe 25-Apr-2022 14:27:11 ™
(= Dats Pesl Hew »
@ Regost T
L3 Stub B
» Ui Test Case Liadli *| © CodeReview
» L Test Hamess Fename... B Cowrage
) :;It Iﬁ mh B Copy ClilaC 2 HTML Reports
. Coverage
Gy Test Suite Resuits K Delete Delete
w g" Biranes fm Impert.. ¥ Text Editor
» %F MUlproj.ece - [amdédle] o — E  System Editor
¥ e Includes 5 n-Place Editer
» & MU Lo il [Cipdais it

2. Select a folder on your disk, or create a new one and click OK. A browser opens with the following index:

x |+

€ Ainditery Termgyncle hird

B | [ DovCps bet Imbeaded - est ¢

(&2~

List of avaliable reports:

Coverage
Code Review

Reports of MUIproj.exe 15-Nov-
2023 11:57:18

m o @ | §

Generated on 15/11/2023, 11:5%:49
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Chapter 4. Creating a test case

You can create a test case from the project by selecting a source file or a function. Each test case focuses on a
particular function.

The following sections display how to create, update and run a test case with DevOps Test Embedded
Opening the call graph
You have various ways to create a test case, and one method involves using the call graph that you can explore.

1. Right click the project MUIproj and from the menu, select Open Call Graph.

If' Project Explorer &3 | B2 CAC++ Projects 't. Mavigator =0
5 csp
=% Demo
=% engineSimulator
15 gear
15 matt Mew »
¥ > MUipre Go Into
(# Tes
1 Bin Open Call Graph
sk Ine Open in New Window
i MU
. & Tes Rename...
= st Move..,
(K] cor [ Copy Ctrl+C
.:
W K Delete Delete
e testger aste S
=% Tutoria o o
i Import...
iy Export..
Build Project
Clean Project

This action opens a new view that contains the call graph of the application:

a0 Gragh computed from WLy

& Tages ) Conspde =l Cot Gragh 11 0 EmerLog 1) Taepet Deptoyment Pont ] Moniiorag 55 Progress B0 P =
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The nodes in this graph represent the functions of the application. Nodes with dotted lines correspond to
functions without available source code (in this example, these are functions in I i bc). The lines between two
nodes are the calls between functions. The top level function is at the left of the graph (in this example it is the
function mai n) and low level functions on the right.

2. Click a node inside the call graph (in the following example, the node MUIpsCompute is selected.

MullagErrar

MU cnnect

AUlloginformati..

MUIbtDisconnect

N=

MUIBAC arfigure | \{

MUlpsCampute MU set Timer ]

MUlwakelp ]

MU=t Turmes

Now the call graph highlights the following:

> The grey node is the selected function

> The blue lines on the right of this node calls to other functions

> The blue lines on the left of this node are links to caller functions

> The blue nodes are functions that are in the same compilation unit
3. Double click on a node, the corresponding source code opens in the editor.

Creating a test

You can now create a test for the function di v. DevOps Test Embedded, a test is composed of two parts:

- Atest case, is the test itself. The test contains the following:
o The call of the function under test.
- A table with the initial values and the expected values of the parameters, the global variables and local
variables that you can add in this test case.
> The stub behaviors relative to this test case.
o Optionally, code that is added in the beginning (#i ncl ude for example) and one or several
requirements.
« A test harness is the container for test cases. One test harness can contain multiple test cases, defining how

the test is built to become an executable program. A test harness:
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° The list of the files under test.

- Additional source files that can be added to the test harness when linking. This option is useful for
software integration test. It is also possible to add object files and libraries.

> The build settings.

o Optionally, code that is be added in the beginning (#i ncl ude for example) and one or several

requirements in such case, these requirements cover all the test cases of the test harness.

In DevOps Test Embedded, test cases and test harnesses are files with the extensions . t est _case and
.test_harness. There are compressed XML files.

1. Right-click the node div and select from the menu. the option New test harness

A new panel appears on the call graph, called Test Creation Activity:

Test Creation Activity P

Lot thap g oo pnant 1t

Best Asnet Selection 7 3nus Gelenon St L remrign Tt bt St

Fowt = Canoel

This is a wizard that helps to create a first test case.

2. Click Next. This is the second page of the wizard. Now the call graph is reduced only to the functions
that are in the same compilation unit (in blue) and the functions that are called by previous one.

MUIpsCompute [ dv_ ]
MUlpsDetectLeak
Ulloginformati... ([ MUlabs ]
(MUlpsSeffcheck - e, .
o] MUIsetTimer . MUllogClear ] strien :
MUlpsCal X
--------------- :
— WlvesefTimer (L maicd
UlpsSetAccuracy R N eessssassnanes .
bernoa CR .S
UlpsGetMeasure MUllogF ull

The objective of this step is to take into account only the functions that are required in your test
harness to link properly with your compilation unit without error. By default, the test harness is linked
only with the compilation unit of the function under test. So, all the referenced functions (nodes in

yellow) generates an error at the link phase as they are missing. The way to avoid that is to stub them.

3. Click the node MUILogInformation.
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wvaid MUllaglnformation(int)

div e sub ]

MUlcheckTimer |
f e e
{....malioc "
ST

pEsEssssanansang,

strcat H

This node is now displayed as a stub, and the node MUl Logd ear disappears from the call graph
because its caller will be stubbed.

4. Continue the sub selection by clicking the nodes MUIsetTimer, MUIresetTimer, MUILogError and
MUIcheckTimer.

wvoid MUlcheckTimer()

psGetheasure

In the end, all the yellow nodes are suppressed, leaving only the blue ones.

5. Click Next. The next page is the test case name. By default, it is the name of the function under test.
You can go with the default.

6. Click Next.The next page is the test harness name. By default, it is the name of the function under test
with the suffix t h_. You can go with the default.

7. Click Finish.
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Editing a test

At the end of the wizard, a test harness that includes one test case is created. This test harness must be open. The

test harness contains two parts:

- On the left panel, an activity diagram that allows to chain the test cases that is run.
« On the right panel, the configuration of the test harness.

th_div
Available e | N notr debectied L
Aty h* oo x Detads (1] _‘l.:li““{_&ﬂg R
Test hamess activity disgeam Contest Defimsen  Buikd Settings | Stubd Regueerents Header Code Declarstions
Specify the Tiles. requaned to Basld the Test Fumess B B F X
. File Enld Ingtruing... Pagh
w [ Fili Uncher Test el =
£ MWN_pressune_tensorn.c | Nl PeBUA e AU s AL pressuine_se.
div L= Additional Seurces
L% Limioed Files

= Labwinrnid

You can go through on the following

« Context definition: Only one file is added as files under test, because you have stubbed all the external calls.
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Note: Thisicon ' indicates that the files under test is included in the code generated for the test
harness. This helps you to have the visibility on static variables and static functions that are hidden

from external compilation units.

« Stubs: You can see here the five selected stubbed functions.

Context Definition | Build Settings | Stubs " Requirements | Header Code | Declarations

Function stubbed by this test hamess: 0 ()| X
Filter: Mame or file ~
Stubbed Function File Run ...
<% woid MUIcheckTimer() fMUlpropMUL src/MUI_timer.c
<% void MUllogEmor{char*) MUlprop MU src/MULlog.c
< void MUlleginformation(int)  /MUlproyMUI/src/MUL_leg.c
<% void MUIresetTimer() fMUlprop UL src/MUI_timer.c

<% void MUlsetTimer() MMUlproj MU src/MUI_timer.c




Getting started with DevOps Test Embedded for Eclipse IDE

¥

.
1. Double click the div icon —

in the activity diagram to open the test case. The activity contains two parts:

> On the left panel, an activity diagram that display the different phases of the test case

= On the right panel, the configuration of the phase that is selected on the activity diagram (the default

one when opening the test case is its general description, that you can open when clicking on the

background of the activity diagram)

div
orpilable runs: | Mo runs pelected
Activity b~ @ Ga
Ttif it Btnaty dugram
¢
Init and Stubs
Q
Code
(@
Check
@

Detaily o
Function under test bl divling, ini) (h.n.gg
P s MU s LI gtetiine &

11 = LR

Degumntaticn . Raguinbmanti
[Puibsirfiotafl [heid rigrtioe
Thig descnption i inchaded = the 14l caie report

Fumchion under tei
int diwiing, ink)

Internal Mot
Thete notes ane not publinbed

Teat cada ganeiated Teom the ¢all graph

2. Click the Code box in the activity diagram: this shows you the generated code for calling the function under

test. You can edit the generated code.

Details

MName: Code
Comment:
Source code:

retvalue = div( a, b ):

The variables retValue, a and b are created locally in the test harness and used as parameters.

3. Click the Check box in the activity diagram,
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Details 8]

MName | Check

Checked Variables g mw A= & =

Enter initial and expected expressions for checked variables:

Cell edition.
Mame Type Initial Expre... @ Expected Ex.. Obtained Value
ma int 0 == Same as Init
@b int 0 = Same as Init
@’ retvalue int Mo Change 0

This table displays all the variables used for the test (parameters and global variables) with:
o Their type
o Their initial expression that represents the value before calling the function under test. No Change
means that this variable is not initialized before calling the function under test.
- Their expected expression that represents the expected value after calling the function under test.
Same as Init mean that the expected value is the same as the initialized value.
o Their obtained expression (i.e. the actual value after calling the function under test). This column is

empty for now. It will be automatically filled after an execution.

Be default, the wizard generates a test case with all the parameters to 0 or null in case of pointers. You can
modify this test case for having the following division 50/7 that should give 7 as result.

4. Click the cell Initial expression of the variable a and enter the value 50.

5. Press enter to validate this value, or click the icon
6. Click the cell Initial expression of the variable b, enter the value 7 and validate it. Do not modify the expected

result of r et val ue for now.

Running a test

You can run test harnesses or test scripts in a single step. You can update the list of test harnesses and test scripts

to be run.

1. Go back to the test harness by clicking on the tab th_div in the editor panel.

2. Click the run icon on the details panel. The console view should display build log... This should take less

than one minute.
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Viewing a test result

After the test run is completed, the test harness editor is updated to display the following result:

1= ey e 0
- th_div
e
Bevallably nane: B th_dea BBl 3500 Dl SE ~ M Fadad P E 1 B L
Ay B - 0| Dol DdesRBRELO O
HE TR L BTy g _—
. Tortcane  diw Change_ | [a4
Cesinpmgrtiatssn . Parpmraioni| Dupeimdersiin
C oovemagnt 150 001 ¢ dik Call
div
M Frded ]
Tl Lase il
E Fusstntry ueader tesk
et dew{id, an)

+ The Available runs field is updated with the last test result and its status is displayed (Failed in this case).
« The activity diagram is updated with the status of each test case (Failed in this case).
- A coverage summary is displayed on the panel.

1. You can hover over this coverage summary that displays a detailed information of the test result.

o 14 _
P B |I D

=

Test Coverage:

Function and exits: 10.0% (4/40)
Statement blocks: 13.8% (5/36)

Implicit blocks: 250% (1/4)
Decisions: 15.0% (6/40)
Loops: 83% (1/12)

IT&J Open full coverage report

2. Click the link Open full coverage report to open the coverage viewer with the information related to the
file under test only.

3. Double click the test case div inside the activity diagram to go to the test case editor that display
additional information related to the last runs:
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th_dne e
div
e
Wovailable rums: | 3 th_dine 03-May- 2022 085356 / die v 3 Failed P B I LD
Actheity El* @G @| 3 Detas )
Test case sctivity diagram Nlﬁ"( Ehffk
A
Variables L = ' (=N R
Init and Stubs Enter initial and expected expressions for checked varisbles
° Name Type Initial Expre.. Q@ Expected Bx_. Obtsined Value
oy it 50 Same 55 Init 97 50
Code a's int 7 Same asInit o 7
W retvalue int Mo Change oXT
9
Check
S Faited
e ¥ < -

= The field Available runs is updated with the last execution result and the status of the test run
is displayed (Failed in this case).

= The activity diagram is updated with the status Failed on the Check box

= A coverage summary is displayed on the panel.

= The column Obtained value is updated with the true values read during the execution and their
status.

Fixing the test case
When you see the value of r et val ue is wrong, you can perform the following:

1. Fix the expected value of ret val ue to 7.
2. Save the test case div .
3. Go to the test harness and re-run the test.
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The test is passed.

th_div ] dry
th_div
Available runs: %% th_div 03-May-2022 09:19:35

Activity [% < ="

est harness actraty diagram

i div W
|

" Passed |

Updating the test case with multiple input values

DevOps Test Embedded allows you to define not only a single value but multiple values for an input variable, and also
for the expected values of an output parameter. For multiple input values, you can:

1. Give a list of values from a minimum value to a maximum value with a defined step,
2. Give a list of values as a list,

3. Give a list of values that come from a datapool.

In the second case, illustrated here is with multiple values on parameter a that should modify the output value of

retval ue.
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1. Click the input Expression of the variable a and select the option Multiple.

Hﬂus&

Type D Initial Expre... @ Expected Ex.. Obtained Value
int 501 w Same as Init %7 50
nt 50 Same as Init ¥ 7
int A &
7
Mo Change
Mo Dump
Series
Multiple

2. A Multiple Variable Initialization dialog box is opened.

3. Select the option Multiple option, and then select 3 in the Values number.

@ Multiple Variable Initialization

@

Type
@ Muttiple C) Data pool
Synchronization
Synchronized with:
Filter:
Values
Values number: | 3 =)

[ Random values intervak

."
LY

0

i

x

4. Click OK.
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A new bar appears on the table. Enter the values 10, 20 and 30 in the three available fields.

Checked Variables

EYNEN W
Mame

I
@ a
@'h

I
@ retvalue

v 220

Type
int
int
int

R El T R|EEXE

I

Imitial Expre... @ Expected Ex... Obtained Value

Same as Init %" 50
Same as Init 9 7

17

Enter initial and expected expressions for checked variables:

|V. V| 3 ':' e

|v33ﬂ

)

6. Click the Expected Expression of the variable r et val ue and select Synchonized from the menu.

5. Press enter to validate these values, or click the icon

L L
Q@. % || = 7
Name Type b Initial Expre... @ Expected Ex... Obtained Value

E s int Multiplel3] = Same as Init &7 50

m'b int 7= Same as Init %7 7

@ retvalue int Mo Change =[ v o7
b1
T
Mo Check
Same as Init
Comparison ¥
Range ¥
Synchronized

7. A new bar appears on the table. Enter the values 1, 2 and 4 in the three available fields.

Checked Variables

Enter initial and expected expressions for checked variables:

R E* I R EXE

ONE i L Vi MBS
Mame Type L} Initial Expre... a Expected Ex... Obtained Value
m'a int Multiple[3] == Same as |nit %7 50
m'b int = Same as Init & 7
@' retvalue int No Change == i haury v &7 7

i)

8. Press enter to validate these values, or click the icon




9. Run this test case. Go to the previous test harness and click the run icon

Chapter 4. Creating a test case

on the details panel.

10. After the test run is completed, the test case is updated with the obtained values. You can navigate to the

three iterations using the breadcrumb bar available on the test case:

div
Awailable rung: %7 th_di 17-May-2022 10:2521  div w & Passed P BT LD
+ b Gy Reration 13 b & a3 4 3 merations.
AW 1° Bl @G @| X Deuks @
=l = Name:  Check
W 3 )
Checked Variables e E|t X BEPE
'.' Enter initial and expected expressicns for chacked variables
I - Coll eedition.
-
Init and Stubs Name Tpe D ntialExpre.. () Expected Ex.. Obtained Value
@ ot Multiphe{3] = Same as nit & 10
o'k t 7 = Same s Init & 7
& retvalue nt Mo Change = w
Q
Code
@
Check
o Pased w
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Notices

This document provides information about copyright, trademarks, terms and conditions for the product
documentation.

© Copyright IBM Corporation 2000, 2016 / © Copyright HCL Technologies Limited 2016, 2021
This information was developed for products and services offered in the US.

HCL® may not offer the products, services, or features discussed in this document in other countries. Consult your
local HCL® representative for information on the products and services currently available in your area. Any reference
to an HCL® product, program, or service is not intended to state or imply that only that HCL® product, program,

or service may be used. Any functionally equivalent product, program, or service that does not infringe any HCL®
intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-HCL® product, program, or service.

HCL® may have patents or pending patent applications covering subject matter described in this document. The
furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing,
to:

HCL

330 Potrero Ave.

Sunnyvale, CA 94085

USA

Attention: Office of the General Counsel

For license inquiries regarding double-byte character set (DBCS) information, contact the HCL® Intellectual Property
Department in your country or send inquiries, in writing, to:

HCL

330 Potrero Ave.
Sunnyvale, CA 94085
USA

Attention: Office of the General Counsel

HCL TECHNOLOGIES LTD. PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to
the information herein; these changes will be incorporated in new editions of the publication. HCL® may make
improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time
without notice.
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Any references in this information to non-HCL® websites are provided for convenience only and do not in any manner
serve as an endorsement of those websites. The materials at those websites are not part of the materials for this
HCL® product and use of those websites is at your own risk.

HCL® may use or distribute any of the information you provide in any way it believes appropriate without incurring
any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of
information between independently created programs and other programs (including this one) and (ii) the mutual use
of the information which has been exchanged, should contact:

HCL

330 Potrero Ave.

Sunnyvale, CA 94085

USA

Attention: Office of the General Counsel

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of

a fee.

The licensed program described in this document and all licensed material available for it are provided by HCL®
under terms of the HCL® Customer Agreement, HCL® International Program License Agreement or any equivalent
agreement between us.

The performance data discussed herein is presented as derived under specific operating conditions. Actual results
may vary.

Information concerning non-HCL® products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. HCL® has not tested those products and cannot confirm
the accuracy of performance, compatibility or any other claims related to non-HCL® products. Questions on the

capabilities of non-HCL® products should be addressed to the suppliers of those products.

Statements regarding HCL®'s future direction or intent are subject to change or withdrawal without notice, and

represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as
completely as possible, the examples include the names of individuals, companies, brands, and products. All of these

names are fictitious and any similarity to actual people or business enterprises is entirely coincidental.
COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques
on various operating platforms. You may copy, modify, and distribute these sample programs in any form without
payment to HCL®, for the purposes of developing, using, marketing or distributing application programs conforming
to the application programming interface for the operating platform for which the sample programs are written. These
examples have not been thoroughly tested under all conditions. HCL®, therefore, cannot guarantee or imply reliability,
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serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind.

HCL® shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must include a copyright notice as
follows:

© (your company name) (year).

Portions of this code are derived from HCL Ltd. Sample Programs.

© Copyright HCL Ltd. 2000, 2022.

Trademarks

HCL®, the HCL® logo, and ibm.com® are trademarks or registered trademarks of HCL Technologies Ltd., registered
in many jurisdictions worldwide. Other product and service names might be trademarks of HCL® or other companies.

Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following terms and conditions.
Applicability

These terms and conditions are in addition to any terms of use for the HCL® website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all proprietary notices
are preserved. You may not distribute, display or make derivative work of these publications, or any portion thereof,
without the express consent of HCL®.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that all proprietary
notices are preserved. You may not make derivative works of these publications, or reproduce, distribute or display

these publications or any portion thereof outside your enterprise, without the express consent of HCL®.
Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either express or

implied, to the publications or any information, data, software or other intellectual property contained therein.

HCL® reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of the
publications is detrimental to its interest or, as determined by HCL®, the above instructions are not being properly
followed.

You may not download, export or re-export this information except in full compliance with all applicable laws and
regulations, including all United States export laws and regulations.
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HCL® MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS ARE
PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT
LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR
PURPOSE.
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